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AV Buy JMP

> Getting Started with JMP

Explore resources designed to help you
quickly learn the basics of JMP right from
your desk.

> Mastering JMP
A webinar series for JMP users of all
experience levels who want to build their

analytic skills.

> New User Welcome Kit

You just got JMP. Now get ready to explore
your data by following our learning road
map.

ight © JMP Statistical Di

> Statistical Thinking Course
Learn practical skills in this free online
statistics course encompassing short videos,

demonstrations, exercises and more.

> JMP Education
We offer training courses at all levels to help

build your knowledge and skill set.

OTHER RESOURCES

> Books with JMP > JMP Blogs

> Case Study Library > Learning Library

> On-Demand Webinars for JMP Users
> Statistics Knowledge Portal
D
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L earn the basics ot JMP*

With short videos & step-by-step
guides

We have created a series of introductory videos with
guides to help get you started with the basic functions
of JMP. This series will guide you through some of the
most commonly used steps in the data analysis
process. Since this introduction is designed to
accompany the free trial of JMP, we recommend
watching the videos and trying the steps yourself in
JMP.

:\‘»'-‘-4",

f

Julian L. Parris | JMP Ambassador

Nine 2 to 5-minute videos
plus a PDF step-by-step guide

-trial/learn-the-basics-of-jmp.html jfmp STATISTICAL
iscovery LLC. All ved. i
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Import Data
Learn how to import Excel data,

+

modify column properties and

|
save your data.

(® Watch video 2:32
> Step-by-step guide (PoF)

Explore Distributions

Become familiar with the red

0
=
[
O
=
n

tr Ei'W.;]‘é' menu, see NOW (

and data tables are linked, and

(® Watch video 2:22
> Step-by-step guide (PDF)

Explore Relationships
Once you learn how to build
better models, use the JMP
Profiler to compare and contrast

them.

(® Watch video 2:s5
> Step-by-step guide

https://www.jmp.com/en us/imp-trial/learn-the-basics-of-jmp.html

Build a Dashboard

Get the full picture by

complete workflow to build
dashboards quickly and easily.
(® Watch video 1:58

> Step-by-step guide (rDF)

Publish Results
Publish analyses and
visualizations to JMP Public,

public.jmp.com.

(® Watch video 3:04
> Step-by-step guide (pDF)

Visualize and Summarize
Data

Build and customize interactive
graphs and tables.

(® Watch video

> Step-by-step guide (roF)

Data Cleanup

Complete basic ¢
preparation using Recode and

Formula Columns.

(® Watch video a:5a
> Step-by-step guide (rDF)

Save and Automate Your

(® Watch video 1:a1
> Step-by-step guide (PDF)

Share Interactive Results
3},/ putting your reports Iin a

browser, you can share your

results with anyone, even if they

don't have JMP.

) Watch video 1:49

Step-by-step guide (roF)



https://www.jmp.com/en_us/jmp-trial/learn-the-basics-of-jmp.html

‘ Topics A ‘ Download All Guides
- LB e

All Topics

JMP Basics

Graphical Displays and Summaries
Probabilities and Distributions

Basic Inference - Proportions and Means
Correlation and Regression

Time Series

Multivariate Methods

Mixed Models and Repeated Measures
Data Mining and Predictive Modeling
Quality and Process

Reliability and Survivability

Using SAS from JMP

ummaries

92 one-page-guides each with
an accompanying short video

juick overviews, videos, and step-by-step tutorials.

> JMP Tools
> JMP Tables Menu
> Saving JMP Results

> Saving Publication Quality Graphics with
JMP
> Sharing Results on JMP Public

> Creating Formulas in JMP
> Excel Add In | (Passing Data to JMP)

> Excel Add In Il (Profiling Excel Models in
JMP)

> Add-In Builder
> JMP Teaching Tools

https://www.jmp.com/en us/learning-library.html
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Recent Uploads P F’LAY ALL WWW yo utu be CO m

Makmg

[Hypothesis

Jmp16

Format Values

in Prediction M JMP Projects

No Code | Testin : 2
| g Profilers Gt ilc Orgamzatlon
Jmp...... - Jmp:
Success Story: Milking the Teaching Text Mining Making Hypothesis Testing Format Values in Prediction Projects in JMP 16
data for all its worth at... Without Writing Code More Intuitive for Our... Profilers JMP Software
JMP Software JMP Software JMP Software JMP Software 836 views * 6 months ago
617 views = 1 month ago 387 views * 1 month ago 258 views * 1 month ago 163 views + 1 month ago

JMP Software

JMP 16 p PLAY ALL 9.94K subscribers

Jmp16

COMPARE
DATA

Term Selection
Sentiment Analysis

Term Selection Sentiment Model Screening | JMP 16 Action Recorder | JMP 16 Control Chart Warning | JMP Compare Data Tables in JMP
Analysis [ JMF 10 JMP Software JMP Software 16 16
JMP Software 1.2K views * 9 months ago 1.1K views = 9 months ago JMP Software JMP Software
1.1K views * 9 months ago o &~ 1.9K views + 9 months ago 840 views + 8 months ago
CcC
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http://www.youtube.com/user/JMPSoftwareFromSAS

Mastering JMP®

M aste ri ng J M P® | Overview | | Application Areas v | - ‘ Upcoming Live Webinars

WEBINARS THAT EXPAND YOUR ANALYTIC SKILLS

- | Application Areas Vv Level A Upcoming Live Webinars

A

All Levels

Advanced

mo fo
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Welcome to the Statistics
Knowledge Portal

Why SKP?

There are many sources of information across the Internet for those seeking to
learn about statistical concepts. Our goal in creating the Statistics Knowledge
Portal, or SKP (affectionately pronounced “skip”), was to uniquely combine
concise explanations with illuminating examples and graphics to help visitors
establish a firm foundation upon which to build statistical skills. Our hope is that
SKP will contribute to the growing appreciation of the value of statistical methods
and will inspire learners to journey farther.

Why Statistics?

Statistics is more than just math, and it's more than just a collection of methods to
analyze data; statistics provides a way to think about the world in a principled
fashion, to interpret the outcomes of events unfolding before us, to see the
structure of things amidst the prevailing noise and randomness of our reality. If

Welcome
Correlation

Simple Linear
Regression

Multiple Linear
Regression

One-Way ANOVA
The t-Test

The Chi-Square
Test

Exploratory Data
Analysis

you work with data right now, or want to start a career where you will, there is https://www.jmp.com/en us/statistics

STATISTICAL
-knowledge-portal.htm| ERedEY

nothing more valuable than a solid foundation in statistical methods.
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Software JMP in Action Events Learn JMP Community Support About Us

Statistical Thinking for Industrial Problem Solving (STIPS)

A free online statistics course

In virtually every field, deriving insights from data is central to problem
solving, innovation and growth. But without an understanding of which
approaches to use, and how to interpret and communicate results, the
best opportunities will remain undiscovered.

That's why we created Statistical Thinking for Industrial Problem

u

Solving (STIPS). This online statistics course is available - for free - to
anyone interested in building practical skills in using data to solve

problems better.
Have two minutes? Learn more.

Enroll now https://www.jmp.com/en us/statistical-thinking.html



https://www.jmp.com/en_us/statistical-thinking.html

> Statistical Thinking and Problem Solving
Statistical thinking is about understanding, controlling
and reducing process variation. Learn about process
rmaps, problem-salving tools for defining and scoping
your project, and understanding the data you need to

solve your problem,

> Exploratory Data Analysis

Learn the basics of how to describe data with graphics
and statistical summaries. Then, learn how to use
interactive visualizations to communicate the story in
your data. You'll also learn some care steps in preparing

your data for analysis,

> Quality Methods

Learn about tools for quantifying, controlling and
reducing variation in your product, service or process,
Topics include control charts, process capakility and

measurement systems a-wa|y9i5.

The instructional method is excellent..The lessons are short

Statistical Thinking for Industrial Problem Solving (STIPS)

> Decision Making With Data

arn about tools used for drawing inferences from
data. In this module you learn about statistical intervals
:nd hypothesis tests. You also learn how to calculate
sample size and see the relationship between sample

size and power.

> Correlation and Regression
Learn how to use scatterplots and correlation to study
the linear association between pairs of variables. Then,

+

lzarn how to fit, evaluate and interpret linear and logistic

regression models.

> Design of Experiments
In this introduction to statistically designed experiments
(DOE), you learn the language of DOE, and see how to

design, conduct and analyze an experiment in JMP.

> Predictive Modeling and Text Mining
Learn how to identify possible relationships, build

predictive models and derive value from free-form text.

and tight. They have just the right amount of complex
information broken down into manageable chunks.

)
‘?n STATISTICAL
” DISCOVERY
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Grow your data analysis skills from
your desk

JMP On Air is our live-streaming video series
featuring fun, fast-paced, educational content.

Thank you for joining us for Season One of JMP
On Air.

Get acquainted with JMP On Air in 30 seconds.

View Past Episodes in the Community

11:40 p.m.  ASK THE DATA DOCTOR
Thinking Like a Data Doctor Yourself

The Data Doctor walks us through the steps he takes to diagnose

and cure data problems to help us learn to think like Data

Joctors ou "SE‘"»’E‘S‘

_'f

12:05 p.m. FEATURED PROGRAM

The Last Things | Wish Someone Had Told Me When |

Started Using JMP

In this final installment, Mike reveals the secrets of JMP Masters.

_'f

Brady Brady
Global Technical
Enablement
Manager, JMP

Mike Anderson

Systems

Engineer, JMP

zht © JMP Statistical Discovery LLC. All righ

Time Program

11:00 a.m. WELCOME
The Monologue

11:10 a.m. FEATURED PROGRAM
Meet the Author: Rob Carver

Anne speak

11:35 a.m. WHY DOE?

In this final installment o

understand which of
to include in our mod
innovation

¥

12:10 p.m. HAVE YOU TRIED?
JMP Projects

JMP projects provide a

le document interface to JMP, a

place to bookmark files
navigate various open
lows, data tables, scripts and more. A project can also be

used to launch supporting files like .pdfs and .ppt documents.

o

12:15 p.m. DR. DOE

How Do | Repair a Broken Experimental Design?

the
response
our model won't run! Dr. DOE will
w ta repair your design using the Augment Design

option in the DOE platform.

¥

Presenter

Julian Parris
Host, JMP On Air

Rob Carver
Author & Retired
Professor at
Stonehill College,
Brandeis

University

Phil Kay
Sr. Systemns

Engineer, JMP

Ryan DeWitt
Sr. Digital
Marketing

Specialist, JMP

Tom Donnelly
Principal Systems

Engineer, JMP
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community.mp.com

Software JMP in Action Events Learn JMP

Community

Support

Community v Discussions File Exchange v JSL Cookbook JMP Wish List

JMP User Community

About Us

JMP Blogs

Sign In With Your SAS Profile

A resource for JMP software users. Start or join a conversation to solve a problem or share tips and tricks

with other JMP users. Read blog posts, and download and share JMP add-ins, scripts and sample data.

Discussions
Solve problems and share tips & tricks
with other JMP users

File Exchange
Download and share JMP add-ins,
scripts, and sample data

JMP Wish List
We want to hear your ideas for improving
JMP. Share them here.

Learn JMP
Extend your JMP skills with on-demand
videos and JMP files

JMP Users Groups
Meet up and discuss with other JMP
users near you

Discovery Summit
Info on upcoming Summits and materials
from past events

Create a SAS Profile and Join the Community

34,919

Members

382,525

Discussions

1,836

Allcommunity  w
Q File Exchange Items

\ JMP Blogs

l Read about a broad range of data
analysis topics and posts that inform your
JMP use

JSL Cookbook
Building blocks of JSL code to reduce
your coding workload.

Community Help
Help with getting started, finding things,
and how the Community works

LATEST POSTS

m STATISTICAL
” DISCOVERY
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JMP User Community = Learn JMP _

The one place to access all JMP learning materials

How to use the Learn JMP area

a Getting Started 28 2 weeks ago
POSTS

« Filter within sections using labels. Or, search the entire Learn JMP area using the search bar and Starthere to learn the basic operation of JMP. Includes the

selecting This category. New User Welcome Kit, Design of Experiments Introduction

Kit, and Resources for Users.
« Stay current by subscribing to particular sections or labels—for instance, you can be notified when

a new visualization resource is posted by selecting Visualization and then Subscribe to this

Short Videos 232 4 weeks ago
label. ﬁ

Short videos and guides to help you learn JMP. Includes POSTS

. . . STIPS (Statistical Thinking for Industrial Problem Solving)
Sign up for Live Webinars

modules.
Visit Mastering JMP and view the Upcoming Complimentary Live Webinars.
2 Mastering JMP 202 Thursday
Additional JMP Learning Resources — Videos of live Mastering JMP demos to help JMP users learn ~ POSTS

to use JMP to solve problems. Includes Q&A plus Journals

+ JMP User Guide and Documentation and files to try techniques show in videos.

« Statistical Thinking for Industrial Problem Solving course. Free online course.

« JMP Newswire. Monthly newsletter. : Learning Paths 15 09-13-2021

Curated learning paths to help you expand your knowledge posTs  10:54 AM
« JMP User Groups. Gathering to share and learn with peers. . i i

of analytical topics, whether you're an advanced user, or just
= Resources for Users. Ensuring you get the most from JMP. starting out.

« JMP Menu Descriptions (Windows | MacOS)

« JMP Keyboard Shortcuts @ Activities 10 05.-11-2921
& Keep your skills sharp with these hands-on data challenges Fosts  11:05AM

and activities.

« JMP Books

o
‘?n STATISTICAL
” DISCOVERY
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WWW.jmp.com/welcome

jmp Software JMP in Action Events Learn JMP Community Support About Us Try JMP Buy JMP

Getting Started With JMP*®

HELPING YOU USE JMP® RIGHT FROM THE START

Overview Live Webcast On-Demand Webcast

J M P NE‘\/“-./ U ser \/\/Q|COT"ﬂe |<|J[ Other supported languages:

Your Complimentary Introduction to JMP > German

The New User Welcome Kit is designed to help

you quickly get comfortable with the basics of Register Now
JMP. You'll complete its thirty short demo videos
and activities, build your confidence in using the
software, and connect with the largest online
community of JMP users in the world.

FIRST NAME *

o
‘?n STATISTICAL
” DISCOVERY
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Help > New Features

14 Highlights in JMP 17 New Features
Graphing

Graphing

STATISTICAL This section describes new features and enhancements in the graphing platforms. For details,
see the Essential Graphing book.
» DISCOVERY
Graph Builder

To assist with color blindness, protanomaly, deuteranomaly, and tritanomaly color theme
filters are now available.

Version 17 )

The sampling feature enables you to choose a proportion, rather than an integer value.
smbine levels into groups, and reorder levels on the axis without

having to edit the column properties.
Mode statistic is now an option in the Summary Statistic report. This option affect:
coloring by the dominant level. To access this option, go to Graph >Graph Builder >
Points. Choose Mode from the Summary Statistic list.
Support is added for multiple response data. Multiple response columns can be used in
each of the Graph Builder zones.

You can use the hash pattern style indicator for bar charts.

- In bar charts, you can show one-sided confidence intervals this option,
New Features in MP 17 right-click on a bar chart> Gustomize > Error Bar. Choose the Upper or Lower option from

the Interval Sides li

If a continuous variable is used as the overlay variable, you can customize the bin values

for the gradient. To access this option, right-click on the gradient in the legend > Gradient.

Choose Custom in the Scale Type list and then change the level values.

There are new ways to associate summary text in graphs and axes. For example, you can
“The real voyage of discovery consists not in seeking new landscapes, now display associated summary tabular data along the axes in Graph Builder. You can

but in having new eyes.” also change the position of the caption box. To ac this option, change the X and Y

position in the Caption Box options. You can customize the location of text in a caption or
text box by right-clicking in the box > Customize > Text.

Marcel Proust

JSL references to Graph Builder are now updated when starting over.
how the coefficient of variation (CV) statistic by selecting it in the Summary
JMP Statistical Discovery LLC
SAS Campus Drive You can change the default color of histogram bars or outlines. To access this option, select
Cary, North Carolina 27513-2414 X File > Preferences > Styles. Choose a color for the Histogram Fill Color and Histogram
: Line Color.

The Constrain Parameters option is now available for Exponential Smoothing (ETS) fits.

STATISTICAL
” DISCOVERY

Copyright © JMP Statistical Discovery LLC. All rights reserved



Books and JMP

New Users

— ] T

Intermediate and Advanced Users

> JMP Documentation

by SAS Institute

» Business Statistics, 3rd Edition

by Norean Sharpe, Dick De Veaux and

Improving

Paul Velleman

> Business Statistics: A First Course,
3rd Edition

by Norean Sharpe, Dick De Veaux and
Paul Velleman

> Data Management and Analysis
Using JMP®: Health Care Case
Studies

by Jane E. Oppenlander and Patricia
Schaffer

> Design of Experiments: A Modern
Approach
by Bradley Jones and Douglas C.

Montgomery

Featured Books

> JMP for Mixed
Models

by Ruth Hummel,
Elizabeth A.
Claassen, and

Russell D. Wolfinger

> Improving
Health Care
Quality: Case
Studies with JMP

by Mary Ann Shifflet,

Cecilia Martinez,
Jane Oppenlander,
and Shirley

Shmerling

> IMP®
Essentials: An
lllustrated Guide
for New Users,
Third Edition

by Curt Hinrichs,
Chuck Boiler, and

Susan Walsh

» See the full catalog of JMP

20 - books at SAS Publishing.

EXPERIMENTS
RNy

> Data Mining for Business
Analytics: Concepts, Applications
and Techniques with JMP Pro

by Galit Shmueli, Peter Bruce, Mia
Stephens, and Nitin Pate

Companion Page o

> Design and Analysis of
Experiments by Douglas
Montgomery: A Supplement for
Using JMP

by Heath Rushing, James Wisnowski, and
Andrew Karl

> Design and Analysis of
Experiments, 8th Edition
by Douglas C. Montgomery

> Strategies for Formulations
Development: A Step-by-Step Guide
Using JMP

by Ronald Snee and Roger Hoerl

> Fundamentals of Predictive
Analytics with JMP, Second Edition
by Ron Klimberg and Bruce McCullough

" www.jmp.com/books

> Activity Based Intelligence
by Patrick Biltgen and Stephen Ryan

> Analysis of Messy Data Volume 1:
Designed Experiments

by George A. Milliken and Dallas

Johnson

> Applied Linear Regression Models
by Christopher J. Nachtsheim and John
Neter

> Applied Reliability, 3rd Edition
by Paul A. Tobias and David Trindade

> Biostatistics Using JMP®: A
Practical Guide
by Trevor Bihl

%

J
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Jmp i terial from
B ke o Fundamentals of Renstzbg.*gg e

Predictive Analytics L ~F
ctive Analvtics | Predictive
Analytics with o I 54599
JMP® Second

Edition

Ron Klimberg

B. D. McCull & ug h

Ron Klimberg - B. D. McCullough

In Stock

://sasinstitute.redshelf.com/app/ecom/book/1878377/fundamentals-of-predictive-analytics-with-jmp- -fm STATISTICAL
second-edition-1878377-978162960801 3-ron-klimber JMP sicazs
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Help > JMP Help

? Tool

F1

jf‘np Statistical Discovery From SAS.

@l 1 M

B Using JMP
B Basic Analysis
M Essential Graphing
& Profilers
M ntroduction to Profilers
& Profiler
Example of the Prediction Profiler
Launch the Prediction Profiler Platform
Prediction Profiler Options
Desirability Profiling and
Construction of Desirability
Functions

How to Use the Desirability
Function

The Desirability Profile
Customized Desirability Functions
Assess Variable Importance
Bagging

M Additional Examples of the
Prediction Profiler

8 Statistical Details for the Prediction
Profiler

B Contour Profiler
M Surface Plot
M Mixture Profiler
B8 Custom Profiler
B Simulator

M Excel Profiler
References

M Design of Experiments Guide

P

Profilers = Profiler > Desirability Profiling and Optimization

Desirability Profiling and Optimization

You can define a desirability function for a single response variable or for several response variables. When you are optimizing relative
to several responses. there can often be competing criteria. For example, you might want to maximize one response, minimize ancther,
and keep a third response close to some target value.

In desirability profiling, you specify a desirability function for each response. The overall desirability for all responses is defined as the
geometric mean of the desirability functions for the individual responses. See Derringer and Suich (1980) for information about

combining responses.

To use desirability prefiling, select Optimization and Desirability > Desirability Functions from the Prediction Profiler red triangle
menu

Note: If the response column has a Response Limits property, desirability functions are turned on by default.

This command appends a new row to the bottom of the plot matrix, dedicated to graphing desirability. The row has a plot for each factor
showing its desirabilify trace, as illustrated in The Desirability Prediction Profiler. It also adds a column that has an adjustable desirability
function for each ¥ variable. The overall desirability measure shows on a scale of zero to one at the left of the row of desirability traces.

The Desirability Prediction Profiler

4 ~|Prediction Profiler

100
90

65.5 80
> (618368 70

69.1634] E“
desirability
function

u
5
g
E

Desirability
0025 0751 82

Desirability

overall desirability

desirabllity traces for desirabllity scale
measure

each factor




You've invested in the most comprehensive, interactive and visual statistical
discovery package out there. It's time to tap into its full potential.

WWW.jmp.com/training

YOUR EDUCATION OPTIONS:

Upcoming Courses
Take an on-demand course.
* We have a fantastic (free!) foundational online on-demand course that you > JMP SCRIPTING LANGUAG
can take at any time. No need to have a JMP license - you get access to JMP JMP®: The JMP® Scripting Language
Pro through a web browser JMP application. Learn more at Statistica Nov. 14 -18]1:00 - 4:30 p.m. ET
Thinking for Industrial Problem Solving.
We offer some free online on-demand courses: > GETTING STARTED

o Introduction to the JSL Scripting Language

We have many online, on-demand courses included in a monthly (or yearly)
subscription. Access one course, or take all of them - it's your choice! Learn

more about the JMP Learning Subsc » DESIGN OF EXPERIMENTS AND QUALITY IMPROVEMENT

JMP: Reliability Analysis for Non-Repairable
Take a synchronous class.

Nov. 2% -Dec. 2| 1:00 - 4:30 p.m. ET

* Take a public online course with a live instructor. Learn about all of our
courses, and find our public course schedule and registration links from our
- » GETTING STARTED

Course Catalog.

* Schedule & private course with a JMP Partner. See the list of JMF

Partners and reach outto them directly.
> DESIGN OF EXPERIMENTS AND QUALITY IMPROVEMENT
Get hel o] from a JMP Partner. JMP®: Custom Design of Experiments
L . _ ‘ Dec.6-91:00 - 4:30 p.m. ET
Let our consulting friends guide you through a tricky analysis, or coach you as
you apply the methods you learned in class. See the list of JMP Partners and

reach out to them directly for consulting or mentoring help.

Overview | JMP Education o o i

m STATISTICAL
” DISCOVERY
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Jim Wisnowski www.adsurgo.com

(] ! Jim is Principal at Adsurgo LLC and has a PhD in industrial
+ =, engineering from Arizona State University with an emphasis in

m ! applied statistics. He was an award-winning professor and

A E?:gr:_g% statis?ics chair at the US Air Forrfe Academ?.f. Jim retired fron‘j
the Air Force, where he held various analytical and leadership

positions throughout the Department of Defense in training,
testing and evaluation, human resources, logistics, systems
engineering and acquisition.

Instructors with DoD Experience

One of Jim’s students said: “Jim is top-notch instructor with
WWW.aasurgo.com vast knowledge of the subject matter. As well, his experience
with DoD and military methodology, tools and policy proved
especially helpful in his interaction with the class. For future
training, | intend to request Jim.”

Heath Rushing
Heath is an American Society of Quality (ASQ) Certified
Quality Engineer and the co-founder and principal consultant
of Adsurgo LLC, a company specializing in advanced analytics
consulting services and training for enhanced business
performance. He has been a professor at the US Air Force /\
Academy as well as a quality engineer and Six Sigma Black

Belt in both biopharmaceutical manufacturing and R&D. Heath -’KAnG’yﬁCS
holds a master's degree in operations research from the Air 7 N~
Force Institute of Technology and has used JMP since 2001.

JK Analytics

One of Heath’s students said: “Heath was very professional United States
and knowledgeable on both statistical analysis and the use of ,

JK Analytics is a small business, veteran, woman owned company specializing in statistical analysis, experimental
JMP software. He kept us on targ et and In‘terjec‘tEd a gOOd design, bio-statistics, operations research, and data analytic services. Their training services include 15 courses in
amount of fun into the course when needed.” statistics, reliability, analytics and design of experiments.



http://www.adsurgo.com/
http://www.adsurgo.com/

WWW.jmp.com/support

Support

Get the Answers You Need

JMP technical support is provided by statisticians and engineers educated in
SAS and JMP, many of whom have graduate degrees in statistics or other
technical disciplines. At SAS, technical support is a career, not just a job.

support@jmp.com
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The JMP® Analytic Workflow

From data to insight — all in one self-service platform

Data Analytic Capabilities Shareable Insights

(® See the JMP workflow in action (16:28)
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JMP Defense & Aerospace Team

Anna-Christina De La Iglesia
JMP Program Manager

anna-christina.delaiglesia@jmp.com
919-531-2593

Sam Tobin _ _

JMP Senior Account Representative Thanks for your interest in JMP.
sam.tobin@jmp.com .

919-531-0640 If you have any questions,

please contact us.
Tom Donnelly, PhD, CAP
JMP Principal Systems Engineer
tom.donnelly@jmp.com
302-489-9291
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